
 

 

PASIŪLYMAS (2018-TIC-115) MOBILIŲJŲ TELEFONŲ IR JŲ PRIEDŲ 

VYKDOMAME  

SKELBIAMŲ DERYBŲ BŪDU 

 

  

  PIRKIMO OBJEKTO DALIAI  

 

1. INFORMACIJA APIE TIEKĖJĄ 

Tiekėjo pavadinimas / Tiekėjų grupės narių pavadinimai UAB TELE2 PREKYBA 

Tiekėjų grupės bendras atstovas arba vadovaujantis 
narys (pildoma, jei pasiūlymą teikia Tiekėjų grupė) 

Rasma Tumbrotaitė 

 

2. SUTIKIMAS SU PIRKIMO SĄLYGOMIS 

Pažymime, kad pateikdami savo Pasiūlymą, sutinkame su Pirkimo sąlygose (kaip jos apibrėžtos Bendrosiose pirkimo 
sąlygose) nustatytomis tolesnėmis Pirkimo procedūromis, Preliminarios sutarties sąlygomis ir būsimos Sutarties 
sąlygomis (tiek bendrąja, tiek specialiąja dalimis).  

Patvirtiname, kad atidžiai perskaitėme visus Pirkimo sąlygų, taip pat ir Techninės specifikacijos, reikalavimus, mūsų 
Pasiūlymas juos visiškai atitinka ir įsipareigojame jų laikytis vykdydami Sutartį. Taip pat įsipareigojame laikytis ir kitų 
Lietuvos Respublikoje galiojančių ir Pirkimo objektui bei Sutarčiai taikomų teisės aktų reikalavimų. Rengdami Pasiūlymą, 
atsižvelgėme į darbų saugos ir darbo sąlygų reikalavimus. 

Jei būsime kviečiami sudaryti Sutartį ir atsisakysime ją sudaryti, įsipareigojame, Įgaliojusiai organizacijai pareikalavus, 
sumokėti Įgaliojusiai organizacijai, 10 proc. Dalyvio Galutinio pasiūlymo kainos EUR be PVM dydžio baudą bei padengti 
Įgaliojusios organizacijos  patirtus tiesioginius nuostolius, kiek jų nepadengia aukščiau nurodyta bauda. Tiesioginiais 
nuostoliais bus laikomas kainos skirtumas tarp Sutartį atsisakiusio pasirašyti Dalyvio Galutinio pasiūlymo kainos EUR 
be PVM ir kito Dalyvio, pasiūlymų eilėje esančio po atsisakiusio sudaryti sutartį Dalyvio, Galutinio pasiūlymo kainos 
EUR be PVM.   

 

 

3. INFORMACIJA APIE PLANUOJAMUS PASITELKTI SUBTIEKĖJUS AR RĖMIMĄSI KITŲ ŪKIO 
SUBJEKTŲ PAJĖGUMAIS 

3.1. Sutarties vykdymui bus pasitelkiami šie subtiekėjai ir ūkio subjektai: 

Eil. 
Nr. 

Ūkio subjekto, 
kurio pajėgumais 

remiamasi,  
Subtiekėjo 

pavadinimas1 

arba Ūkio 
subjekto 

(specialisto), 
kuris nėra 

Tiekėjo 
darbuotojas, 

vardas ir 
pavardė1  

Ar pats Tiekėjas ar 
Tiekėjų grupės narys 
atitinka kvalifikacijos 
reikalavimą, kuriam 
pasitelkiami kitų ūkio 
subjektų pajėgumai 
(pabraukti tinkamą) 

Kvalifikacijos reikalavimų, kuriems 
atitikti bus naudojami kiti ūkio 
subjekto pajėgumai ir darbai, 

kuriems bus pasitelkiami 

subtiekėjais, pobūdis2 (pagal SPS 

4 priedo II dalyje „Reikalavimai 
kvalifikacijai“ (nurodyti konkretų 

punktą)  

Sutarties dalis, kuriai 
pasitelkiamas 

subtiekėjas ir kuriam 
nekeliami kvalifikacijos 

reikalavimai 

1. UAB TELE2 Taip/Ne SPS 4 priedo II dalyje 
„Reikalavimai kvalifikacijai“ 1 ir 2 
punktuose reikalaujami įvykdytų 
sutarčių patirties atitikimo 
kvalifikacija; 

SPC 4.5.5 punktą - Tiekėjas yra 
įgaliotas atlikti siūlomų mobilių 
telefonų garantinę priežiūrą ir 
techninį aptarnavimą. 

Garantinis 
aptarnavimas ir įvykdytų 
sutarčių  patirties 
reikalavimo atitikimas. 

Lentelėje Tiekėjo nurodytus kvalifikacinius reikalavimus gali atitikti Tiekėjas ir (ar) ūkio subjektas arba abu kartu.  

                                                 
1 Nurodomas konkretus Subtiekėjo pavadinimas, jei žinomas Pasiūlymas pateikimo metu. Jei ketinama pasitelkti, tačiau konkretus 
pavadinimas nėra žinomas, nurodoma „nežinomas“. 
2 Toks perdavimas nekeičia pagrindinio Tiekėjo atsakomybės dėl numatomos sudaryti Sutarties įvykdymo. 



 

 

Pasitelkiamo ūkio subjekto vietoje žymėjimo „Nežinomas“ atveju, Tiekėjas/Tiekėjų grupė patvirtina, kad atitinka 
Sutarties daliai, kuriai  pasitelkiamas „Nežinomas“ ūkio subjektas, taikomus kvalifikacinius reikalavimus. 
 

Kartu su Pasiūlymu Tiekėjas turi pateikti tų ūkio subjektų, kurių atliekamiems darbams keliami kvalifikacijos reikalavimai, 
užpildytus ir pasirašytus EBVPD, kurie nebuvo pateikti, teikiant Paraišką. 

Pirkėjui paprašius, pateiksime subtiekėjų (ūkio subjektų) deklaracijų, užpildytų pagal Paraiškos formos Priede pateiktą 
formą, skaitmenines kopijas, patvirtinančiais jų sutikimą būti Tiekėjo Subtiekėjais Pirkėjo atliekamame Pirkime. 

Pirkėjui paprašius, pateiksime ūkio subjektų (specialistų) deklaracijų dėl sutikimo būti įdarbintu Tiekėjo laimėjimo atveju, 
užpildytų pagal Paraiškos formos Priede pateiktą formą, skaitmenines kopijas, patvirtinančiais jų sutikimą būti įdarbintu 
Pirkėjo atliekamame Pirkime. 

Pirkėjui paprašius, pateiksime įrodymus, kad, vykdant Sutartį, mums bus prieinami lentelėje nurodytų ūkio subjektų 
pajėgumai.  

 

4. PASIŪLYMO KAINA 

4.1. Informacija apie pasiūlymų teikimą: 
  

Pirkimo 

objekto dalies 

numeris 

Pirkimo objekto pavadinimas 

Informaciją apie Paraiškų teikimą 

(pildo Tiekėjas, nurodoma, kurioje 

Pirkimo objekto dalyje bus teikiama 

Paraiška) 

1.  
II Pirkimo objekto dalis – Android  OS Mobilieji 

telefonai ir jų priedai 
Teikiamas   

 

4.2. Pasiūlymo kaina nurodoma eurais.  

4.3. Pasiūlymo kaina nurodoma užpildant pateiktas lenteles: 

 
II Pirkimo objekto dalis – Android  OS Mobilieji telefonai ir jų priedai: 

 

Eil. Nr. Pirkimo objektas 
Bendra kaina, EUR be 

PVM3 
PVM, EUR 

Pasiūlymo kaina, 
EUR su PVM 

1 2  3 4 5 

1. Prekės, kurių sąrašas pateiktas 
Pasiūlymo formos Priede Nr.5 

551 700,00 115 857,00 667 557,00 

 

Pasiūlymo kaina turi apimti visas išlaidas, visus mokesčius, mokėtinus pagal galiojančius Lietuvos Respublikos 
įstatymus, įskaitant sąskaitų pateikimo kaštus per „E.sąskaita“ sistemą. Tai nėra Pirkėjo įsipareigojimas Laimėjusiam 
Dalyviui sumokėti nurodytą sumą sutarties galiojimo laikotarpiu. Laimėjusiam Dalyviui bus sumokama tik už faktišką 
kiekį.   

5. PASIŪLYMO GALIOJIMO TERMINAS 

Pasiūlymas galioja BPS 10.1. punkte nurodytą terminą.   

 

6. PASIŪLYMO FORMOS PRIEDAI  
6.1. Priedas Nr. 1 Tiekėjo rekvizitai ir kita informacija; 
6.2. Priedas Nr. 2 Konfidenciali informacija; 
6.3. Priedas Nr. 3 Deklaracija dėl jungtinei veiklai susivienijusių tiekėjų grupės dalyvavimo pirkime (teikiamas tuo 

atveju, jei Pasiūlymą teikia jungtinei veiklai susivienijusių tiekėjų grupė). 
6.4. Priedas Nr. 4 Prekių atitikties techninės specifikacijos reikalavimams lentelė, 
6.5. Priedas Nr. 5. Pasiūlymo kaina. 

 
 

Pasirašydamas šį pasiūlymą, tvirtintu visų kartu su pasiūlymu pateikiamų dokumentų tikrumą. 

 

                                                 
3 Bendra kaina EUR be PVM nurodyta Pasiūlymo formos Priede Nr.5., bus naudojama pasiūlymų vertinimui. Pasiūlymo kaina 

EUR be PVM turi apimti visas išlaidas, visus mokesčius, išskyrus PVM mokestį, mokėtinus pagal galiojančius Lietuvos Respublikos 
įstatymus, įskaitant sąskaitų pateikimo kaštus per „E.sąskaita“ sistemą. Tai nėra Pirkėjo įsipareigojimas Laimėjusiam Dalyviui 
sumokėti nurodytą sumą sutarties galiojimo laikotarpiu. Laimėjusiam Dalyviui bus sumokama tik už faktišką kiekį. 



 

 

Viešojo sektoriaus augimo ir plėtros 
partnerė 

  

Rasma Tumbrotaitė 
 

 

Pasiūlymo formos priedas Nr.1  

TIEKĖJO REKVIZITAI IR KITA INFORMACIJA 

 

Tiekėjo pavadinimas / Tiekėjų grupės narių pavadinimai UAB TELE2 PREKYBA 

Tiekėjo adresas(-ai)4 (jei skiriasi, taip pat nurodyti ir adresą 
korespondencijai) 

Upės g. 23, LT-08128 Vilnius 

Juridinio asmens kodas(-ai)8 (tuo atveju, jei Pasiūlymą 
pateikią fizinis asmuo - verslo pažymėjimo Nr. ar pan.) 

302473332 

Tiekėjo PVM mokėtojo kodas(-ai)8 LT100005143111   

Tiekėjo / Tiekėjų grupės bendro atstovo arba 
vadovaujančio nario sąskaitos numeris ir banko 
pavadinimas 

LT64 7300 0101 2049 4438, 73000 AB Swedbank 

Tiekėjo / Tiekėjų grupės bendro atstovo arba 
vadovaujančio nario  telefono numeris 

+37067573333 

Pasiūlymo pasirašymui Tiekėjo / Tiekėjų grupės bendro 
atstovo arba vadovaujančio nario įgalioto asmens vardas, 
pavardė 

Rasma Tumbrotaitė 

Pasiūlymą pateikusio Tiekėjo / Tiekėjų grupės bendro 
atstovo arba vadovaujančio nario kontaktinio asmens  
vardas ir pavardė 

 

Pasiūlymą pateikusio Tiekėjo / Tiekėjų grupės bendro 
atstovo arba vadovaujančio nario kontaktinio asmens  
telefono numeris / Mobilaus telefono numeris 

Rasma Tumbrotaitė 

Pasiūlymą pateikusio Tiekėjo / Tiekėjų grupės bendro 
atstovo arba vadovaujančio nario kontaktinio asmens  
elektroninio pašto adresas 

 

Sutarties vykdymui Tiekėjo / Tiekėjų grupės bendro 
atstovo arba vadovaujančio nario įgalioto asmens vardas, 
pavardė, tel. Nr., el. paštas. 

+37067573333 

Sutartį pasirašančio asmens vardas, pavardė, 

pareigos, teisinis atstovavimo pagrindas5, kuriuo 

suteikiama asmeniui teisė pasirašyti sutartį įmonės 
vardu.  

RASMA.TUMBROTAITE@TELE2.LT 

Įmonės bendrieji rekvizitai, kurie Konkurso laimėjimo 
atveju, bus nurodomi sutartyje: telefono numeris, 
elektroninio pašto adresas, fakso numeris. 

Rasma Tumbrotaitė 

 
PASTABA: Jei pasiūlymą pateikia Tiekėjų grupė, Tiekėjo rekvizitus ir kitą informaciją turi pateikti kiekvienas tokios grupės narys. 

 

Viešojo sektoriaus augimo ir plėtros 
partnerė 

  

Rasma Tumbrotaitė 
 

                                                 
4 Tuo atveju, jei Pasiūlymą teikia Tiekėjų grupė, pateikiama informacija apie visus Tiekėjų grupės narius. 
5 Nurodoma įgaliojimo arba įsakymo  data ir numeris arba kito dokumento (įmonės įstatai, nuostatai ar pan.) data ir numeris.  



 

Pasiūlymo formos priedas Nr. 2  

KONFIDENCIALI INFORMACIJA*  

(šią lentelę bus prašoma užpildyti tik galimai laimėjusio dalyvio) 

 
*PASTABA: Konfidencialios informacijos lentelės pildymo instrukcija pateikiama kartu su Pirkimo dokumentais CVP IS. 

 

Atkreipiame Tiekėjų dėmesį, kad žemiau lentelėje nurodyta Pasiūlymuose pateikiama informacija bus viešinama vadovaujantis viešuosius pirkimus reglamentuojančių 
teisės aktų nuostatomis bei Viešųjų pirkimų tarnybos bei teismų formuojama praktika. 

 
Užpildytos formos ir kita pateikiama 

informacija6 
Viešinimo pagrindas 

Pateikiamas dokumentas viešinimui 
(išskyrus informaciją, kurios 
atskleidimas negalimas pagal Asmens 
duomenų teisinės apsaugos įstatymą)7 

1 2 3 4 

1.  

Pasiūlymo forma (be priedų, bei Tiekėjo 
(juridinio asmens) informaciją, nurodytą 
šios pasiūlymo formos 1 dalyje, kuri bet 
kokiu atveju negali būti laikoma 
konfidencialia informacija) 

Viešinama vadovaujantis ir VPĮ 20 straipsnio 2 dalimi / PĮ 32 straipsnio 2 
dalimi. Priedas Nr. 6 

Pasiūlymo forma. II daliai.docx
 

2.  Tiekėjo rekvizitai ir kita informacija 
Viešinama vadovaujantis VPĮ 20 straipsnio 2 dalimi/ PĮ 32 straipsnio 2 dalimi, 
išskyrus informaciją, kurios atskleidimas negalimas pagal Asmens duomenų 
teisinės apsaugos įstatymą. 

Priedas Nr. 6 

Pasiūlymo forma. II daliai.docx
 

3.  
Tiekėjo EBVPD forma ir pagrindžiantys 
dokumentai 

Viešinama vadovaujantis VPT ir teismų formuojama praktika, kad tiekėjo 
kvalifikaciniai duomenys, kuriais tiekėjas remiasi siekdamas laimėti viešąjį 
pirkimą, negali būti laikomi konfidencialia informacija, išskyrus tokius 
kvalifikaciją pagrindžiančius dokumentus, kuriuos atskleidus būtų pažeisti 
tiekėjo įsipareigojimai pagal su trečiaisiais asmenimis sudarytas sutartis (VPĮ 
20 str. 2 d. 3 p. / PĮ 32 str. 2 d. 3 p.). 

 

4.  
Subtiekėjų EBVPD forma ir 
pagrindžiantys dokumentai 

Viešinama vadovaujantis VPT ir teismų formuojama praktika, kad tiekėjo 
kvalifikaciniai duomenys, kuriais tiekėjas remiasi siekdamas laimėti viešąjį 
pirkimą, negali būti laikomi konfidencialia informacija, išskyrus tokius 
kvalifikaciją pagrindžiančius dokumentus, kuriuos atskleidus būtų pažeisti 

NETEIKIAMA 

                                                 
6 Atskiri dokumentai ar šiuose dokumentuose pateikiama informacija gali būti nurodoma atskirose eilutėse, atsižvelgiant į informacijos konfidencialumą. Atsižvelgiant į informacijos konfidencialumą, pateikiami 
konfidencialumą įrodantys dokumentai ir argumentai. 
7 Dokumentas įkeliamas: INSERT -> Object -> Create From File -> Browse -> Display as icon -> ok. Pateiktas dokumentas laimėjimo atveju bus paviešintas. Tiekėjas įsipareigoja užtikrinti, kad dokumente 
nėra konfidencialios ir negalimos viešinti informacijos. 



 

 

tiekėjo įsipareigojimai pagal su trečiaisiais asmenimis sudarytas sutartis (VPĮ 
20 str. 2 d. 3 p. / PĮ 32 str. 2 d. 3 p.). 

5.  
Tiekėjų kvalifikaciją pagrindžiančių 
dokumentų sąrašas 

Viešinama vadovaujantis VPĮ 20 straipsnio 2 dalimi/ PĮ 32 straipsnio 2 dalimi, 
pateikta informacija, išskyrus informaciją, kurios atskleidimas negalimas 
pagal Asmens duomenų teisinės apsaugos įstatymą. 

Registrų centro pažyma, įvykdytų 
sutarčių sąrašas. 

6.  

VĮ Registrų centro LR Vyriausybės 
nustatyta tvarka išduotas dokumentas, 
patvirtinantis jungtinius kompetentingų 
institucijų tvarkomus duomenis. 

Viešinama vadovaujantis VPĮ 20 straipsnio 2 dalimi/ PĮ 32 straipsnio 2 dalimi, 
pateikta informacija, išskyrus informaciją, kurios atskleidimas negalimas 
pagal Asmens duomenų teisinės apsaugos įstatymą. 

 

7.  
Subtiekėjo deklaracija dėl sutikimo būti 
subtiekėju 

Viešinama vadovaujantis VPĮ 20 straipsnio 2 dalimi/ PĮ 32 straipsnio 2 dalimi, 
pateikta informacija, išskyrus informaciją, kurios atskleidimas negalimas 
pagal Asmens duomenų teisinės apsaugos įstatymą. 

NETEIKIAMA 

8.  
Prekių įkainiai 

Viešinama vadovaujantis VPĮ 20 straipsnio 2 dalimi/ PĮ 32 straipsnio 2 dalimi, 
VPT ir teismų formuojama praktika, išskyrus įkainių sudedamąsias dalis. 

NEVIEŠINAMA 

 

Siekiant užtikrinti, kad laimėjusių Dalyvių pasiūlymuose esančios informacijos paskelbimas neprieštarautų teisės aktų reikalavimams, teisėtiems Tiekėjų interesams arba 
netrukdytų laisvai konkuruoti tarpusavyje, prašome nurodyti, ar Pasiūlyme yra konfidencialios informacijos ir kokia Pasiūlyme nurodyta informacija yra konfidenciali.8  

Eil. 

Nr. 

Užpildytos formos ir kita 
pateikiama informacija9 

Ar dokumentas 
konfidencialus? 

(Taip / Ne / 
Neteikiama) 

Kokiu pagrindu atitinkamas dokumentas yra 
(ne)konfidencialus? 

Pateikiamas dokumentas viešinimui (išskyrus 
informaciją, kurios atskleidimas negalimas 
pagal Asmens duomenų teisinės apsaugos 

įstatymą)10 

1 2 3 4 5 

1.  
Prekių atitikties Techninės 
specifikacijos reikalavimams 
lentelė 

Ne 
Informacija gali būti laikytina konfidencialia, išskyrus 
atvejus, jeigu atitinkama informacija skelbiama viešai 
arba tiekėjas nurodo, kad nėra konfidencialu. 

 

                                                 
8 Lentelėje žemiau pateikiama informacija apie Pasiūlyme nurodytos informacijos konfidencialumą. Dalyvis privalo nurodyti, ar jo Pasiūlyme yra konfidencialios informacijos, ir kuri Pasiūlyme nurodyta informacija yra 
konfidenciali. Nurodant, jog informacija yra konfidenciali, prašome kartu su pasiūlymu pateikti konfidencialumą įrodančius dokumentus ir argumentus. Visas Dalyvio Pasiūlymas negali būti laikomas konfidencialia 
informacija. 
Tuo atveju, jei lentelė ar atskiros jos eilutės nėra užpildomos, Pirkėjas laikys, kad ta Pasiūlymo informacija arba atitinkama jos dalis nėra laikoma konfidencialia.  
Atkreipiame dėmesį, kad vadovaujantis VPĮ ir (arba atitinkamai PĮ), Konfidencialia negali būti laikoma informacija, kuri atitinka VPĮ 20 straipsnio 2 dalyje ir (arba atitinkamai PĮ 32 straipsnio 2 dalyje) nustatytus požymius ir 
sąlygas, o Pirkėjui kilus abejonių dėl Dalyvio Pasiūlyme nurodytos informacijos konfidencialumo, ji  kreipiasi į Dalyvį su prašymu įrodyti nurodytos informacijos konfidencialumą. Per Pirkėjo nurodytą terminą (kuris negali 
būti trumpesnis kaip 5 darbo dienos) Dalyviui nepateikus tokių įrodymų arba pateikus netinkamus įrodymus, laikoma, kad tokia Pasiūlyme nurodyta informacija yra nekonfidenciali. 
9 Atskiri dokumentai ar šiuose dokumentuose pateikiama informacija gali būti nurodoma atskirose eilutėse, atsižvelgiant į informacijos konfidencialumą. 
10 Dokumentas įkeliamas: INSERT -> Object -> Create From File -> Browse -> Display as icon -> ok. Pateiktas dokumentas laimėjimo atveju bus paviešintas. Tiekėjas įsipareigoja užtikrinti, kad dokumente 
nėra konfidencialios ir negalimos viešinti informacijos. 



 

 

2.  
Jungtinės veiklos sutartis (jei 
Pasiūlymą pateikia Tiekėjų 
grupė) 

Taip  
Informacija gali būti laikytina konfidencialia, išskyrus 
atvejus, jeigu atitinkama informacija skelbiama viešai 
arba tiekėjas nurodo, kad nėra konfidencialu. 

- 

3.  
Deklaracija dėl jungtinei veiklai 
susivienijusių tiekėjų grupės 
dalyvavimo pirkime 

Taip Informacija laikytina konfidencialia. 
- 

4.  
Konfidencialios informacijos 
pagrindimas 

Neteikiama 
Informacija gali būti laikytina konfidencialia, išskyrus 
atvejus, jeigu atitinkama informacija skelbiama viešai 
arba tiekėjas nurodo, kad nėra konfidencialu. 

- 

 

Viešojo sektoriaus augimo ir plėtros partnerė 
 

 

Rasma Tumbrotaitė 
 



KONFIDENCIALU 

Pasiūlymo formos priedas Nr. 3  

 

UAB TELE2 PREKYBA IR UAB TELE2 
  

DEKLARACIJA DĖL JUNGTINEI VEIKLAI SUSIVIENIJUSIŲ TIEKĖJŲ GRUPĖS DALYVAVIMO PIRKIME  
2018 12 18 

  
Vilnius 

  
Mes, Jungtinei veiklai susivienijusių tiekėjų grupė UAB TELE2 PREKYBA IR UAB TELE2 

(Jungtinei veiklai susivienijusių tiekėjų grupės pavadinimas)  
kurią sudaro UAB TELE2 PREKYBA IR UAB TELE2, astovaujantys asmenys Skirmantas Ketvirtis ir Rasma Tumbrotaitė 
 
(toliau – Jungtinei veiklai susivienijusių tiekėjų grupė), dalyvaudami UAB Verslo aptarnavimo centro (toliau – Perkančioji 
organizacija) vykdomame viešajame pirkime Mobiliųjų telefonų ir jų priedų pirkimas (toliau – Pirkimas), patvirtina, 
kad Pirkime dalyvaujanti Jungtinei veiklai susivienijusių tiekėjų grupė: 

1. nedalyvauja Lietuvos Respublikos konkurencijos įstatymo 5 straipsnyje nurodytuose draudžiamuose 
susitarimuose ir susitarimuose, pažeidžiančiuose Lietuvos Respublikos viešųjų pirkimų įstatymo 17 
straipsnyje nustatytus principus; 

2. Pirkime dalyvauja jungtinės veiklos pagrindu, kooperuodami narių pajėgumus (patirtį, kvalifikaciją, žinias, 
„know how“ ar kt.), siekia pateikti efektyviausią ir ekonomiškai naudingiausią bendrą pasiūlymą bei, Pirkimo 
laimėjimo atveju, tinkamai įvykdyti viešo pirkimo sutartį; 

3. nei vienas Jungtinei veiklai susivienijusių tiekėjų grupės narys objektyviai negali individualiai dalyvauti Pirkime 
bei pateikti atskirų pasiūlymų Pirkime dėl žemiau nurodytų priežasčių:  

3.1. nei vienas Jungtinei veiklai susivienijusių tiekėjų grupės narys atskirai (individualiai) negali pasiūlyti 
Pirkimo objekto visa apimtimi; 

3.2. šio Pirkimo atveju nėra objektyvių aplinkybių ir galimybių Jungtinei veiklai susivienijusių tiekėjų grupės 
nariams išplėsti savo pajėgumų ir pateikti pasiūlymus individualiai; 

3.3. nei vienas Jungtinei veiklai susivienijusių tiekėjų grupės narys atskirai (individualiai) nėra teikęs 
pasiūlymo, vykdęs arba įvykdęs panašaus pobūdžio ir (arba) apimties viešojo pirkimo sutarties per 
paskutinius 12 mėnesių.  

3.4. nei vienas Jungtinei veiklai susivienijusių tiekėjų grupės narys atskirai (individualiai) negali pateikti 
pasiūlymo vienai, kelioms arba visoms pirkimo objekto dalims, jeigu šio Pirkimo objektas yra suskaidytas 
į pirkimo objekto dalis ir tiekėjams leidžiama pateikti pasiūlymus vienai, kelioms arba visoms pirkimo 
objekto dalims; 

4. šio Pirkimo atveju Jungtinei veiklai susivienijusių tiekėjų grupės narių skaičius yra optimalus ir pakankamas 
tam, kad, Pirkimo laimėjimo atveju, Pirkimo sutartis būtų įvykdyta tinkamai, ir toks narių skaičius niekaip (jokia 
apimtimi) neriboja konkurencijos; 

5. kiekvienas iš šio Pirkimo atveju Jungtinei veiklai susivienijusių tiekėjų grupės narių, priimdamas sprendimą, 
kad neturi galimybių pateikti savarankišką pasiūlymą Pirkime ir priimdamas sprendimą Pirkime dalyvauti 
jungtinės veiklos pagrindu, objektyviai įsivertino ir išanalizavo su savo veikla susijusias aplinkybes, be kita 
ko, apimančias jo finansinius išteklius, techninius pajėgumus, žmogiškuosius išteklius, specifines žinias, 
„know-how“; kitas objektyvias aplinkybes;  

6. Jungtinei veiklai susivienijusių tiekėjų grupės pateikiami papildomi paaiškinimai ir (arba) patvirtinimai  

7. priimdama sprendimą šiame Pirkime dalyvauti jungtinės veiklos pagrindu, objektyviai, skaidriai ir neturėdama 
tikslo riboti tiekėjų konkurencijos, taip pat vadovaudamasi Lietuvos Respublikos konkurencijos įstatymo ir kitų 
teisės aktų nuostatomis, įvertino visas šioje deklaracijoje nurodytas sąlygas; 

8. žino ir supranta, kad Perkančioji organizacija, įvertinusi pateiktą deklaraciją ir joje nurodytus duomenis, 
pasilieka teisę Pirkimo procedūrų metu (bet kurioje Pirkimo stadijoje) kreiptis į Jungtinei veiklai susivienijusių 
tiekėjų grupę ar atskirus jos narius ir prašyti pateikti deklaracijoje nurodytus duomenis patvirtinančius 
dokumentus bei įrodymus. 

 
Mums, Jungtinei veiklai susivienijusių tiekėjų grupės nariams visiems kartu ir kiekvienam nariui atskirai yra žinoma, kad 
jeigu mūsų pateikta deklaracija yra melaginga (visi arba dalis deklaracijoje nurodomų duomenų), atsakomybė gali būti 
taikoma teisės aktų nustatyta tvarka, o tiekėjui, kuris su kitais tiekėjais yra sudaręs susitarimų, kuriais siekiama iškreipti 
konkurenciją atliekamame pirkime, ir Perkančiajai organizacijai dėl to turint įtikinamų duomenų, toks tiekėjas gali būti 
pašalinamas iš pirkimo procedūros, vadovaujantis Lietuvos Respublikos viešųjų pirkimų įstatymo 46 str. 4 d. 1 p. 
nuostatos pagrindu. 
 
  

Viešojo sektoriaus augimo ir plėtros 
partnerė 
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Pasiūlymo formos priedas Nr. 4 

 

PREKIŲ ATITIKTIES TECHNINĖS SPECIFIKACIJOS REIKALAVIMAMS LENTELĖ 

 

 

 
Pirkimo objektas Nr.2 – Android OS Mobilieji telefonai ir jų priedai 
 

Nr. 
Pirkimo 

objektas 

Prekių Techniniai reikalavimai 2  

(Prekės turi būti ne prastesnių ar 

žemesnių techninių reikalavimų nei 

nurodyta) 

Siūlomų Prekių 
pavadinimas/ 
Modelis 
 
Siūlomų Prekių atitiktis 

reikalavimams (Atitinka / 

Neatitinka) 

Pateikiamos 

nuorodos į kartu su 

Pasiūlymu 

pateiktus 

dokumentus 

pagrindžiančius 

Prekių atitikimą  

1 2 3 4 5 

1 
Mobilus 
telefonas 1 

1. Palaikomi ryšio ir duomenų perdavimo standartai: 
1.1. GSM / HSPA / LTE; 
1.2. HSPA 42.2/5.76 Mbps, LTE Cat9 450/50 Mbps; 
1.3. Bluetooth v4.2, A2DP, LE, aptX; 
1.4. USB 2.0, micro USB; 
1.5. Wi-Fi 802.11 a/b/g/n/ac, dual-band, Wi-Fi 

Direct, hotspot; 
1.6. A-GPS ir GLONASS; 
1.7. NFC „Near Field Communication“; 
1.8. proximity sensor (atstumo jutiklis), 

fingerprint sensor (piršto atspaudo jutiklis), 
accelerometer (akcelerometras), 
barometer (barometras), 
HR sensor (HR jutiklis), 
gyro sensor (giroskopinis jutiklis). 

2. Ekranas: 
2.1. Ekrano dydis 5.5‘‘; 
2.2. Ekrano tipas Super Amoled; Curved edge 

screen; 
2.3. Ekrano raiška  1440 x 2560; 
2.4. Ekrano spalvos 16M; 
2.5. Sensorinio ekrano tipas capacitive; 
2.6. Ekrano apsauga: Corning Gorilla Glass 4. 
3. Baterija: 
3.1. Talpa ne mažiau Li-Ion 3000 mAh. 
4. Atmintis, Procesorius: 
4.1. RAM atmintis 4 GB; 
4.2. Vidinė telefono atmintis  32 GB; 
4.3. MicroSD kortelės palaikymas iki 200 GB; 
4.4. CPU Quad-core 2.3 GHz Mongoose + Quad-

core 1.6 GHz Cortex-A53; 
4.5. GPU Mali-T880 MP12. 
5. Programinė įranga: 
5.1. Android OS, v6.0 (Marshmallow); 
5.2. Naršyklė HTML5. 
6. Kamera: 
6.1. Galinė kamera: 12 MP, f/1.7, phase detection 

autofocus, OIS, LED flash, 2160p@30fps, 
HDR, dual-video rec.; 

6.2. Priekinė kamera: 5 MP, f/1.7, dual video call, 
Auto HDR. 

7.    Spalva – juodas. 

Samsung S7 
32GB 

www.tele2.lt 

2 
Mobilus 
telefonas 2 

1. Palaikomi ryšio ir duomenų perdavimo standartai: 
1.1. GSM / HSPA / LTE; 
1.2. HSPA 42.2/5.76 Mbps, LTE Cat9 450/50 Mbps; 
1.3. Bluetooth v4.2, A2DP, LE, aptX; 
1.4. USB 2.0, micro USB; 

Samsung 
Galaxy J6 

www.tele2.lt 



 

 

1.5. Wi-Fi 802.11 a/b/g/n/ac, dual-band, Wi-Fi 
Direct, hotspot; 

1.6. A-GPS ir GLONASS; 
1.7. NFC „Near Field Communication“; 
1.8. proximity sensor (atstumo jutiklis), 

fingerprint sensor (piršto atspaudo jutiklis), 
accelerometer (akcelerometras) , 
barometer (barometras), 
HR sensor (HR jutiklis), 
gyro sensor (giroskopinis jutiklis). 

2. Ekranas: 
2.1. Ekrano dydis 5.1‘‘; 
2.2. Ekrano tipas Super Amoled; 
2.3. Ekrano raiška  1440 x 2560; 
2.4. Ekrano spalvos 16M; 
2.5. Sensorinio ekrano tipas capacitive; 
2.6. Ekrano apsauga Corning Gorilla Glass 4. 
3. Baterija: 
3.1. Talpa ne mažiau Li-Ion 3000 mAh. 
4. Atmintis, Procesorius: 
4.1. RAM atmintis 4 GB; 
4.2. Vidinė telefono atmintis  32 GB; 
4.3. MicroSD kortelės palaikymas iki 200 GB; 
4.4. CPU Quad-core 2.3 GHz Mongoose + Quad-

core 1.6 GHz Cortex-A53; 
4.5. GPU Mali-T880 MP12. 
5. Programinė įranga: 
5.1. Android OS, v6.0 (Marshmallow); 
5.2. Naršyklė HTML5. 
6. Kamera: 
6.1. Galinė kamera: 12 MP, f/1.7, phase detection 

autofocus, OIS, LED flash, 2160p@30fps, 
HDR, dual-video rec; 

6.2. Priekinė kamera: 5 MP, f/1.7, dual video call, 
Auto HDR. 

7.      Spalva – juodas. 

3 
Mobilus 
telefonas 3 

1. Palaikomi ryšio ir duomenų perdavimo standartai: 
1.1. GSM 850/900/1800/1900; 
1.2. WCDMA 850/900/1900/2100; 
1.3. 3G; 4G LTE; 
1.4. Bluetooth v4.2, A2DP, LE; 
1.5. 2.0, Type-C 1.0 reversible connector; 
1.6. Wi-Fi 802.11 a/b/g/n/ac, dual-band, WiFi Direct, 

hotspot; 
1.7. A-GPS ir GLONASS; 
1.8. proximity sensor (atstumo jutiklis), 

accelerometer (akcelerometras) , 
compass (kompasas), 
barometer (barometras), 
Fingerprint (pirštų atspaudų skaitytuvas). 

2. Ekranas:  
2.1. Ekrano dydis 4.7‘‘, Super AMOLED; 
2.2. Ekrano raiška HD 720 x 1280; 
2.3. Ekrano spalvos 16M; 
2.4. Sensorinio ekrano tipas capacitive; 
2.5. Ekrano apsauga Corning Gorilla Glass 4; 
2.6. Baterija: talpa ne mažiau 2350 mAh. 
3. Atmintis, Procesorius: 
3.1. RAM atmintis 2 GB; 
3.2. Vidinė telefono atmintis 16 GB; 
3.3. MicroSD kortelės palaikymas iki 256 GB; 
3.4. CPU Octa-core 1.6 GHz Cortex-A53; 
3.5. GPU Mali-T830 MP1. 
4. Programinė įranga: 
4.1. Android OS, v6.0.1 (Marshmallow); 

Xiaomi Redmi  
6A 

www.tele2.lt 



 

 

4.2. IMAP4,POP3,SMTP protokolai; 
4.3. Naršyklė WAP 2.0, xHTML, HTML5. 
5. Kamera: 
5.1. Galinė kamera 13 MP, f/1.9, autofocus, LED 

flash, 1080p Full HD filmavimas; 
5.2. Priekinė kamera 8 MP, f/1.9. 
6.    Spalva – juodas. 

4 
Mobilus 
telefonas 4 

1.    Palaikomi ryšio ir duomenų perdavimo 
standartai: 

1.1. GSM 850/900/1800/1900; 
1.2. WCDMA 850/900/1900/2100; 
1.3. 3G; 4G LTE; 
1.4. Bluetooth v4.2, A2DP, LE; 
1.5. USB 2.0, micro USB; 
1.6. Wi-Fi 802.11 b/g/n, Wi-Fi Direct, hotspot; 
1.7. A-GPS ir GLONASS; 
1.8. proximity sensor (atstumo jutiklis), 

accelerometer (akcelerometras). 
2. Ekranas:  
2.1. Ekrano dydis 5‘‘, PLS; 
2.2. Ekrano raiška HD 720 x 1280; 
2.3. Ekrano spalvos 16M; 
2.4. Sensorinio ekrano tipas capacitive; 
2.5. Baterija: talpa ne mažiau 2400 mAh. 
3. Atmintis, Procesorius: 
3.1. RAM atmintis 2 GB; 
3.2. Vidinė telefono atmintis 16 GB; 
3.3. MicroSD kortelės palaikymas iki 256 GB; 
3.4. CPU Quad-core 1.4 GHz Cortex-A53; 
3.5. GPU Mali-T720 MP2. 
4. Programinė įranga: 
4.1. Android OS, v7.0 (Nougat); 
4.2. IMAP4,POP3,SMTP protokolai; 
4.3. Naršyklė WAP 2.0, xHTML, HTML5. 
5. Kamera: 
5.1. Galinė kamera 13 MP, f/1.9, autofocus, LED 

flash, 1080p Full HD filmavimas; 
5.2. Priekinė kamera 5 MP, f/2.2, LED flash. 
   Spalva – juodas. 

Samsung 
Galaxy S8 
64GB 

www.tele2.lt 

5 
Mobilus 
telefonas 5 

1. Palaikomi ryšio ir duomenų perdavimo standartai: 
1.1. GSM 850/900/1800/1900; 
1.2. WCDMA 850/900/1700/1900/2100; 
1.3. 3G; 4G LTE-A Pro Cat 16(1000/150 Mbits/s); 
1.4. Bluetooth v5.0, A2DP, LE, aptX; 
1.5. USB v3.1, Type-C 1.0 reversible connector; 
1.6. Wi-Fi 802.11 a/b/g/n/ac, dual-band, DLNA, WiFi 

Dir, hotspot 
1.7. A-GPS, GLONASS, BDS, GALILEO  
1.8. proximity sensor (atstumo jutiklis), 

accelerometer (akcelerometras) , 
compass (kompasas), 
Gyroscope (giroskopas), 
Fingerprint (pirštų atspaudas), 
Light sensor (šviesos jutiklis). 

2. Ekranas:  
2.1. Ekrano dydis 5.8‘‘, Super AMOLED 
2.2. Ekrano raiška 1440 x 2960 
2.3. Ekrano spalvos 16M 
2.4. Sensorinio ekrano tipas capacitive; 
2.5. Ekrano apsauga Corning Gorilla Glass 5 
2.6. Ekrano ir korpuso santykis 84.26 % 
2.7. PPI pikselių tankumas ekrane 570 
2.8. Baterija: talpa ne mažiau 3000 mAh, 
3. Atmintis, Procesorius: 
3.1. RAM atmintis 4 GB 

Samsung  
Galaxy S8 
Plus 64 GB 

www.tele2.lt 



 

 

3.2. Vidinė telefono atmintis 64 GB; 
3.3. MicroSD kortelės palaikymas iki 256 GB; 
3.4. CPU Octa-core 4x2.3 GHz & 4x1.7 GHz 
3.5. GPU Adreno 540 
4. Programinė įranga; 
4.1. Android OS 7.0 Nougat 
4.2. IMAP4,POP3,SMTP protokolai; 
4.3. Naršyklė HTML5; 
5. Kamera: 
5.1. Galinė kamera 12 MP, f/1.7, autofocus, OIS, 

LED flash, 3840x2160 (4K) (30 fps), 
2560x1440 (QHD), 1920x1080 (1080p HD) (60 
fps), 1280x720 (720p HD) (240 fps) filmavimas 

5.2. Priekinė kamera 8 MP, f/1.7 autofocus 
6.    Spalva – Midnight Black 
7.    Korpusas: 
7.1.  Aliuminis ir Stiklas; 
7.2.  Matmenys 148.9x68.1x8.0 mm 
7.3.   Apsaugos sertifikatai IP68 

6 
Mobilus 
telefonas 6 

1.   Palaikomi ryšio ir duomenų perdavimo 
standartai: 

1.1. GSM 850/900/1800/1900; 
1.2. WCDMA 850/900/1700/1900/2100; 
1.3. 3G; 4G LTE-A Pro Cat 16(1000/150 Mbits/s); 
1.4. Bluetooth v5.0, A2DP, LE, aptX; 
1.5. USB v3.1, Type-C 1.0 reversible connector; 
1.6. Wi-Fi 802.11 a/b/g/n/ac, dual-band, DLNA, WiFi 

Dir, hotspot 
1.7. A-GPS, GLONASS, BDS, GALILEO  
1.8. proximity sensor (atstumo jutiklis), 

accelerometer (akcelerometras) , 
compass (kompasas), 
Gyroscope (giroskopas), 
Fingerprint (pirštų atspaudas), 
Light sensor (šviesos jutiklis). 

2. Ekranas:  
2.1. Ekrano dydis 6.2‘‘, Super AMOLED 
2.2. Ekrano raiška 1440 x 2960 
2.3. Ekrano spalvos 16M 
2.4. Sensorinio ekrano tipas capacitive; 
2.5. Ekrano apsauga Corning Gorilla Glass 5 
2.6. Ekrano ir korpuso santykis 83.32 % 
2.7. PPI pikselių tankumas ekrane 529 
2.8. Baterija: talpa ne mažiau 3500 mAh, 
3. Atmintis, Procesorius: 
3.1. RAM atmintis 4 GB 
3.2. Vidinė telefono atmintis 64 GB; 
3.3. MicroSD kortelės palaikymas iki 256 GB; 
3.4. CPU Octa-core 4x2.3 GHz & 4x1.7 GHz 
3.5. GPU Adreno 540 
4. Programinė įranga; 
4.1. Android OS 7.0 Nougat 
4.2. IMAP4,POP3,SMTP protokolai; 
4.3. Naršyklė HTML5; 
5. Kamera: 
5.1. Galinė kamera 12 MP, f/1.7, autofocus, OIS, 

LED flash, 3840x2160 (4K) (30 fps), 
2560x1440 (QHD), 1920x1080 (1080p HD) (60 
fps), 1280x720 (720p HD) (240 fps) filmavimas 

5.2. Priekinė kamera 8 MP, f/1.7 autofocus 
6.    Spalva – Midnight Black 
7.    Korpusas: 
7.1.  Aliuminis ir Stiklas; 
7.2.  Matmenys 159.5x73.4x8.1 mm 
7.3.  Apsaugos sertifikatai IP68 

CAT B30 www.tele2.lt 



 

 

7 
Mobilus 
telefonas 7 

1. Palaikomi ryšio ir duomenų perdavimo standartai: 
1.1. GSM 850/900/1800/1900; 
1.2. HSDPA 900/2100; 
1.3. 3G; 
1.4. EDGE; 
1.5. Bluetooth v2.1; 
1.6. USB 2.0, micro USB; 
1.7. Klaviatūra – mygtukinė; 
1.8. Korpussas:  

- IP67 certified - dust and water resistant 
- Water resistant up to 1 meter and 30 minutes 
- Drop-to-concrete resistance from up to 1.8m. 

2. Ekranas:  
2.1. Ekrano dydis 2.0‘‘; 
2.2. Ekrano tipas TFT; 
2.3. Ekrano raiška 144 x 176; 
2.4. Ekrano apsauga - Scratch-proof glass; 
2.5. PPI 114. 
3. Baterija:  
3.1. Talpa ne mažiau 1000 mAh; 
3.2. Budėjimo trukmė 240h; 
3.3. Pokalbio trukmė 6 h. 
4. Atmintis: 
4.1. RAM atmintis 256 MB; 
4.2. Vidinė telefono atmintis 1 GB; 
4.3. MicroSD kortelės palaikymas iki 16 GB. 
5. Kamera: 
5.1    Galinė kamera 2 MP. 

Samsung 
Galaxy S9 64 
GB 

 

8 
Mobilus 
telefonas 8 

1. Palaikomi ryšio ir duomenų perdavimo standartai: 
1.1. GSM 850/900/1800/1900; 
1.2. WCDMA 850/900/1700/1900/2100; 
1.3. 3G; 4G LTE-A (6CA) Cat18 1200/200 Mbits/s; 
1.4. Bluetooth v5.0, A2DP, LE, aptX; 
1.5. USB v3.1, Type-C 1.0 reversible connector; 
1.6. Wi-Fi 802.11 a/b/g/n/ac, dual-band, WiFi Direct, 

hotspot 
1.7. A-GPS, GLONASS, BDS, GALILEO  
1.8. DUAL SIM, pokalbio metu aktyvi viena kortelė 
1.9. proximity sensor (atstumo jutiklis), 

accelerometer (akcelerometras) , 
compass (kompasas), 
Gyroscope (giroskopas), 
Fingerprint (pirštų atspaudas), 
Heart rate (širdies ritmo jutiklis), 
Iris scanner (akies rainelės skaitytuvas), 
Light sensor (šviesos jutiklis). 

2. Ekranas:  
2.1. Ekrano dydis 5.8‘‘, Super AMOLED 
2.2. Ekrano raiška 1440 x 2960 
2.3. Ekrano spalvos 16M 
2.4. Sensorinio ekrano tipas capacitive; 
2.5. Ekrano apsauga Corning Gorilla Glass 5 
2.6. Ekrano ir korpuso santykis 83.6 % 
2.7. PPI pikselių tankumas ekrane 570 
2.8. Baterija: talpa ne mažiau 3000 mAh, 
3. Atmintis, Procesorius: 
3.1. RAM atmintis 4 GB 
3.2. Vidinė telefono atmintis 64 GB; 
3.3. MicroSD kortelės palaikymas iki 400 GB; 

3.4. CPU Octa-core (4x2.7 GHz Mongoose M3 & 
4x1.8 GHz Cortex-A55) - EMEA 

3.5. GPU Mali-G72 MP18 - EMEA 
4. Programinė įranga; 
4.1. Android OS 8.0 Oreo 
4.2. IMAP4,POP3,SMTP protokolai; 

Samsung 
Galaxy S9+ 64 
GB 

www.tele2.lt 



 

 

4.3. Naršyklė HTML5; 
5. Kamera: 

5.1. Galinė kamera 12 MP, f/1.5-2.4, 1/2.5", 1.4µm, 
OIS, dual pixel PDAF, LED flash, auto-HDR, 
panorama, 2160p@60fps, 1080p@240fps 
filmavimas 

5.2. Priekinė kamera 8 MP, f/1.7 autofocus 
6.    Spalva – Black 
7.    Korpusas: 
7.1.  Aliuminis ir Stiklas; 
7.2.  Matmenys 147.6x68.7x8.4 mm 
7.3.   Apsaugos sertifikatai IP68 
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Mobilus 
telefonas 9 

1. Palaikomi ryšio ir duomenų perdavimo standartai: 
1.1. GSM 850/900/1800/1900; 
1.2. WCDMA 850/900/1700/1900/2100; 
1.3. 3G; 4G LTE-A (6CA) Cat18 1200/200 Mbits/s; 
1.4. Bluetooth v5.0, A2DP, LE, aptX; 
1.5. USB v3.1, Type-C 1.0 reversible connector; 
1.6. Wi-Fi 802.11 a/b/g/n/ac, dual-band, WiFi Direct, 

hotspot 
1.7. A-GPS, GLONASS, BDS, GALILEO  
1.8. DUAL SIM, pokalbio metu aktyvi viena kortelė 
1.9. proximity sensor (atstumo jutiklis), 

accelerometer (akcelerometras) , 
compass (kompasas), 
Gyroscope (giroskopas), 
Fingerprint (pirštų atspaudas), 
Heart rate (širdies ritmo jutiklis), 
Iris scanner (akies rainelės skaitytuvas), 
Light sensor (šviesos jutiklis). 

2. Ekranas:  
2.1. Ekrano dydis 6.2‘‘, Super AMOLED 
2.2. Ekrano raiška 1440 x 2960 
2.3. Ekrano spalvos 16M 
2.4. Sensorinio ekrano tipas capacitive; 
2.5. Ekrano apsauga Corning Gorilla Glass 5 
2.6. Ekrano ir korpuso santykis 84.2 % 
2.7. PPI pikselių tankumas ekrane 529 
2.8. Baterija: talpa ne mažiau 3500 mAh, 
3. Atmintis, Procesorius: 
3.1. RAM atmintis 6 GB 
3.2. Vidinė telefono atmintis 64 GB; 
3.3. MicroSD kortelės palaikymas iki 400 GB; 

3.4. CPU Octa-core (4x2.7 GHz Mongoose M3 & 
4x1.8 GHz Cortex-A55) - EMEA 

3.5. GPU Mali-G72 MP18 - EMEA 
4. Programinė įranga; 
4.1. Android OS 8.0 Oreo 
4.2. IMAP4,POP3,SMTP protokolai; 
4.3. Naršyklė HTML5; 
5. Kamera: 
5.1. Galinė kamera: Dual  12 MP, f/1.5-2.4, 26mm, 

1/2.55", 1.4µm, Dual Pixel PDAF, OIS,  
12 MP, f/2.4, 52mm, 1/3.6", 1µm, AF, OIS, 2x 
optical zoom 
2160p@60fps, 1080p@240fps, 720p@960fps, 
HDR, dual-video rec. 

5.2. Priekinė kamera 8 MP, f/1.7 autofocus 
6.    Spalva – Black 
7.    Korpusas: 
7.1.  Aliuminis ir Stiklas; 
7.2.  Matmenys 157.7x73.8x8.5 mm 
7.3.   Apsaugos sertifikatai IP68 

 Samsung 
Galaxy A6 32 
GB 

www.tele2.lt 
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1. Palaikomi ryšio ir duomenų perdavimo standartai: 
1.1. GSM 850/900/1800/1900; 
1.2. WCDMA 850/900/1900/2100; 
1.3. 3G; 4G LTE Cat 6 (300/50 Mbit/s) 
1.4. Bluetooth v4.2, A2DP, EDR, LE; 
1.5. 2.0, Type-C 1.0 reversible connector; 
1.6. Wi-Fi 802.11 a/b/g/n/ac, dual-band, WiFi Direct, 

hotspot; 
1.7. A-GPS ir GLONASS, BDS; 
1.8. proximity sensor (atstumo jutiklis), 

accelerometer (akcelerometras) , 
compass (kompasas), 
barometer (barometras), 
Fingerprint (pirštų atspaudų skaitytuvas). 

2. Ekranas:  
2.1. Ekrano dydis 5.2‘‘, Super AMOLED; 
2.2. Ekrano raiška HD 1080 x 1920; 
2.3. Ekrano spalvos 16M; 
2.4. Sensorinio ekrano tipas capacitive; 
2.5. Baterija: talpa ne mažiau 3000 mAh. 
3. Atmintis, Procesorius: 
3.1. RAM atmintis 3 GB; 
3.2. Vidinė telefono atmintis 32 GB; 
3.3. MicroSD kortelės palaikymas iki 256 GB; 
3.4. CPU Octa-core 1.9 GHz Cortex-A53; 
3.5. GPU Mali-T830 MP3. 
4. Programinė įranga: 
4.1. Android OS, v6.0.1 (Marshmallow); 
4.2. IMAP4,POP3,SMTP protokolai; 
4.3. Naršyklė WAP 2.0, xHTML, HTML5. 
5. Kamera: 

5.1. Galinė kamera 16 MP, f/1.9, 27mm, autofocus, 

LED flash, panorama, HDR, 1080p@30fps 
Full HD filmavimas; 

5.2. Priekinė kamera 16 MP, f/1.9. 
   Spalva – juodas. 

Samsung 
Galaxy Xcover 
4 
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1. Palaikomi ryšio ir duomenų perdavimo standartai: 
1.1. GSM 850/900/1800/1900; 
1.2. WCDMA 850/900/1900/2100; 
1.3. 3G; 4G LTE Cat 4 (150/50 Mbit/s) 
1.4. Bluetooth v4.2, A2DP, LE; 

1.5. microUSB 2.0; 
1.6. Wi-Fi 802.11 a/b/g/n, dual-band, WiFi Direct, 

hotspot; 
1.7. A-GPS ir GLONASS, BDS; 
1.8. proximity sensor (atstumo jutiklis), 

accelerometer (akcelerometras) , 
compass (kompasas). 

2. Ekranas:  

2.1. Ekrano dydis 5‘‘,IPS LCD; 
2.2. Ekrano raiška HD 720 x 1280; 
2.3. Ekrano spalvos 16M; 
2.4. Sensorinio ekrano tipas capacitive; 
2.5. Baterija: talpa ne mažiau 2800 mAh. 
3. Atmintis, Procesorius: 
3.1. RAM atmintis 2 GB; 
3.2. Vidinė telefono atmintis 16 GB; 
3.3. MicroSD kortelės palaikymas iki 256 GB; 

3.4. CPU Quad-core 1.4 GHz Cortex-A53; 

3.5. GPU Mali-T720 MP2. 
4. Programinė įranga: 

4.1. Android OS, v7.0 (Nougat); 
4.2. IMAP4,POP3,SMTP protokolai; 
4.3. Naršyklė HTML5, 

MP4/H.264 player, 

Huawei P20 
Pro 

www.tele2.lt 



 

 

MP3/WAV/eAAC+/FLAC player, 
Photo/video editor, 
Document viewer. 

5. Kamera: 

5.1. Galinė kamera 13 MP, f/1.9, autofocus, LED 
flash, Geo-tagging, touch focus, face detection, 
HDR, panorama, 1080p@30fps filmavimas; 

5.2. Priekinė kamera 5 MP, f/2.2. 
6.      Spalva – juodas. 
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1.    Palaikomi ryšio ir duomenų perdavimo 
standartai: 

1.1. GSM 850/900/1800/1900; 
1.2. WCDMA 850/900/1700/1900/2100; 
1.3. 3G; 4G LTE; 
1.4. Bluetooth v4.2, A2DP, LE, aptX; 
1.5. USB v3.1, Type-C 1.0 reversible connector; 
1.6. Wi-Fi 802.11 a/b/g/n/ac, dual-band, WiFi Direct, 

hotspot 
1.7. A-GPS, GLONASS, BDS, GALILEO  
1.8. DUAL SIM, pokalbio metu aktyvi viena kortelė 
1.9. proximity sensor (atstumo jutiklis), 

accelerometer (akcelerometras) , 
compass (kompasas), 
Gyroscope (giroskopas), 
Fingerprint (pirštų atspaudas), 

Color spectrum. 
2. Ekranas:  
2.1. Ekrano dydis 6.1‘‘, OLED 
2.2. Ekrano raiška 1080 x 2244 
2.3. Ekrano spalvos 16M 
2.4. Sensorinio ekrano tipas capacitive; 
2.5. Ekrano ir korpuso santykis 81.9 % 
2.6. PPI pikselių tankumas ekrane 408 
2.7. Baterija: talpa ne mažiau 4000 mAh, 
3. Atmintis, Procesorius: 
3.1. RAM atmintis 6 GB; 
3.2. Vidinė telefono atmintis 128 GB; 
3.3. CPU Octa-core (4 × 2.36 GHz Cortex A73 + 4 × 

1.8 GHz Cortex A53 + micro core i7 Kirin 970); 
3.4. GPU Mali-G72 MP12. 
4. Programinė įranga; 
4.1. Android OS 8.1 Oreo; 
4.2. IMAP4,POP3,SMTP protokolai; 
4.3. Naršyklė HTML5; 
5. Kamera: 
5.1. Galinė kamera: Triple  40 MP, f/1.8, 27mm, 

1/1.7", OIS, PDAF/Laser AF 
20 MP B/W, f/1.6, 27mm, 1/2.7", OIS, 
PDAF/Laser AF 
8 MP, f/2.4, 80mm, 1/4", 3x optical zoom, OIS, 
PDAF/Laser AF,  

2160p@30fps, 1080p@60fps, 1080p@30fps 
(gyro-EIS), 720p@960fps, double LED flash 

5.2.  Priekinė kamera 24 MP, f/2.0 26mm, autofocus 
6.   Korpusas: 
6.1.  Metalas ir Stiklas; 
6.2.  Matmenys 155x73.9x7.8 mm 
7.3.   Apsaugos sertifikatai IP67 

 Huawei P20 
64 GB 

www.tele2.lt 
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1.    Palaikomi ryšio ir duomenų perdavimo 
standartai: 

1.1. GSM 850/900/1800/1900; 
1.2. WCDMA 850/900/1700/1900/2100; 
1.3. 3G; 4G LTE; 
1.4. Bluetooth v4.2, A2DP, LE; 
1.5. USB v3.1, Type-C 1.0 reversible connector; 

Huawei P20 
Lite 
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1.6. Wi-Fi 802.11 a/b/g/n/ac, dual-band, WiFi Direct, 
hotspot; 

1.7. A-GPS, GLONASS, Beidou ; 
1.8. DUAL SIM, pokalbio metu aktyvi viena kortelė; 
1.9. proximity sensor (atstumo jutiklis), 

accelerometer (akcelerometras) , 
compass (kompasas), 
Gyroscope (giroskopas), 
Fingerprint (pirštų atspaudas), 

Color spectrum. 
2. Ekranas:  
2.1. Ekrano dydis 5.8‘‘,LTPS IPS LCD; 
2.2. Ekrano raiška 1080 x 2244; 
2.3. Ekrano spalvos 16M 
2.4. Sensorinio ekrano tipas capacitive; 
2.5. Ekrano ir korpuso santykis 80.7 %; 
2.6. PPI pikselių tankumas ekrane 428; 
2.7. Baterija: talpa ne mažiau 3400 mAh, 
3. Atmintis, Procesorius: 
3.1. RAM atmintis 4 GB; 
3.2. Vidinė telefono atmintis 128 GB; 
3.3. CPU Octa-core (4 x „Cortex A73“, 2,36 GHz + 4 

x „Cortex A53“, 1,8 GHz); 
3.4. GPU Mali-G72 MP12. 
4. Programinė įranga; 
4.1. Android OS 8.1 Oreo; 
4.2. IMAP4,POP3,SMTP protokolai; 
4.3. Naršyklė HTML5; 
5. Kamera: 

5.1    Galinė kamera: Dual 12 MP, f/1.8, 27mm, 
1/2.3", 1.55µm, OIS,  
         PDAF  & laser AF; 
         20 MP B/W, f/1.6, 27mm, 2x lossless zoom, 
PDAF, Leica   
         optics, LED flash, HDR, panorama, 
2160p@30fps,  
         1080p@60fps, 1080p@30fps (gyro-EIS), 
720p@960fps 
5.2.  Priekinė kamera 24 MP, f/2.0 1080p@30fps, 
autofocus 
6.   Korpusas: 
6.1.  Metalas ir Stiklas; 
6.2.  Matmenys 149.1x70.8x7.65 mm 
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1.    Palaikomi ryšio ir duomenų perdavimo 
standartai: 

1.1. GSM 850/900/1800/1900; 
1.2. WCDMA 850/900/1700/1900/2100; 
1.3. 3G; 4G LTE Cat6 300/50 Mbps; 
1.4. Bluetooth v4.2, A2DP, LE, EDR, aptx HD; 
1.5. USB 2.0, Type-C 1.0 reversible connector; 
1.6. Wi-Fi 802.11 a/b/g/n/ac, dual-band, WiFi Direct, 

hotspot; 
1.7. A-GPS, GLONASS; 
1.8. DUAL SIM, pokalbio metu aktyvi viena kortelė; 
1.9. proximity sensor (atstumo jutiklis), 

accelerometer (akcelerometras) , 
compass (kompasas), 
Gyroscope (giroskopas), 
Fingerprint (pirštų atspaudas). 

2. Ekranas:  
2.1. Ekrano dydis 5.84‘‘,LTPS IPS LCD; 
2.2. Ekrano raiška 1080 x 2280; 
2.3. Ekrano spalvos 16M 
2.4. Sensorinio ekrano tipas capacitive; 
2.5. Ekrano ir korpuso santykis 80.5 %; 

Huawei Mate 
20 Pro (128 
GB) 
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2.6. PPI pikselių tankumas ekrane 432; 
2.7. Baterija: talpa ne mažiau 3000 mAh, 
3. Atmintis, Procesorius: 
3.1. RAM atmintis 4 GB; 
3.2. Vidinė telefono atmintis 64 GB; 
3.3. MicroSD kortelės palaikymas iki 256 GB; 
3.4. CPU Octa-core (4x2.36 GHz Cortex-A53 & 

4x1.7 GHz Cortex-A53); 
3.5. GPU Mali-T830 MP2. 
4. Programinė įranga; 
4.1. Android OS 8.0 Oreo; 
4.2. IMAP4,POP3,SMTP protokolai; 
4.3. Naršyklė HTML5; 
5. Kamera: 

5.1    Galinė kamera: Dual 16 MP, f/2.2, 1.0µm, 
PDAF 
        2 MP, depth sensor, LED flash, HDR, 
panorama,   
        1080p@30fps;          
5.2.  Priekinė kamera 16 MP, f/2.0 28mm, 1080p. 
6.   Korpusas: 
6.1.  Metalas ir Stiklas; 
6.2.  Matmenys 148.6x71.2x7.4 mm 
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1.    Palaikomi ryšio ir duomenų perdavimo 
standartai: 

1.1. GSM 850/900/1800/1900; 
1.2. WCDMA 850/900/1700/1900/2100; 
1.3. 3G; 4G LTE-A (3CA) Cat18 1200/150 Mbps; 
1.4. Bluetooth v4.2, A2DP, LE, aptX; 
1.5. USB v3.1, Type-C 1.0 reversible connector; 
1.6. Wi-Fi 802.11 a/b/g/n/ac, dual-band, WiFi Direct, 

hotspot 
1.7. A-GPS, GLONASS, BDS;  
1.8. DUAL SIM, pokalbio metu aktyvi viena kortelė 
1.9. proximity sensor (atstumo jutiklis), 

accelerometer (akcelerometras) , 
compass (kompasas), 
Gyroscope (giroskopas), 
Fingerprint (pirštų atspaudas), 

Barometer. 
2. Ekranas:  
2.1. Ekrano dydis 6‘‘, OLED; 
2.2. Ekrano raiška 1080 x 2160; 
2.3. Ekrano spalvos 16M 
2.4. Sensorinio ekrano tipas capacitive; 
2.5. Ekrano ir korpuso santykis 80.9 % 
2.6. PPI pikselių tankumas ekrane 402 
2.7. Baterija: talpa ne mažiau 4000 mAh, 
3. Atmintis, Procesorius: 
3.1. RAM atmintis 6 GB; 
3.2. Vidinė telefono atmintis 128 GB; 
3.3. CPU Octa-core (4 × 2.36 GHz Cortex A73 + 4 × 

1.8 GHz Cortex A53 + micro core i7 Kirin 970); 
3.4. GPU Mali-G72 MP12. 
4. Programinė įranga; 
4.1. Android OS 8.0 Oreo; 
4.2. IMAP4,POP3,SMTP protokolai; 
4.3. Naršyklė HTML5; 
5. Kamera: 

5.1. Galinė kamera: Dual  12 MP, f/1.6, 27mm, 
1/2.9", 1.25µm, OIS, PDAF & laser AF; 
20 MP B/W, f/1.6, 27mm, 2x lossless zoom, 
OIS, PDAF/Laser AF; 

2160p@30fps, 1080p@60fps, 1080p@30fps. 
5.2.  Priekinė kamera 8 MP, f/2.0 26mm, autofocus 

Huawei Honor 
8X  
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6.   Korpusas: 
6.1.  Aliuminis ir Stiklas; 
6.2.  Matmenys 154.2x74.5x7.9 mm 
7.3.   Apsaugos sertifikatai IP67 
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1.    Palaikomi ryšio ir duomenų perdavimo 
standartai: 

1.1. GSM 850/900/1800/1900; 
1.2. WCDMA 850/900/1700/1900/2100; 
1.3. 3G; 4G LTE-A (2CA) Cat6 300/50 Mbps; 
1.4. Bluetooth v4.2, A2DP, LE, aptX; 
1.5. USB v3, micro USB; 
1.6. Wi-Fi 802.11 a/b/g/n/ac, dual-band, WiFi Direct, 

hotspot 
1.7. A-GPS, GLONASS, BDS;  
1.8. DUAL SIM, pokalbio metu aktyvi viena kortelė 
1.9. proximity sensor (atstumo jutiklis), 

accelerometer (akcelerometras) , 
compass (kompasas), 
Gyroscope (giroskopas), 
Fingerprint (pirštų atspaudas). 

2. Ekranas:  
2.1. Ekrano dydis 5.9‘‘,IPS LCD; 
2.2. Ekrano raiška 1080 x 2160; 
2.3. Ekrano spalvos 16M 
2.4. Sensorinio ekrano tipas capacitive; 
2.5. Ekrano ir korpuso santykis 76.5 % 
2.6. PPI pikselių tankumas ekrane 409 
2.7. Baterija: talpa ne mažiau 3340 mAh, 
3. Atmintis, Procesorius: 
3.1. RAM atmintis 4 GB; 
3.2. Vidinė telefono atmintis 64 GB; 
3.3. MicroSD kortelės palaikymas iki 256GB; 

3.4. CPU Octa-core (4x2.36 GHz Cortex-A53 & 
4x1.7 GHz Cortex-A53); 

3.5. GPU Mali-T830 MP2. 
4. Programinė įranga; 
4.1. Android OS 8.0 Oreo; 
4.2. IMAP4,POP3,SMTP protokolai; 
4.3. Naršyklė HTML5; 
5. Kamera: 

5.1. Galinė kamera: Dual  16 MP, f/2.2, 27mm, 
PDAF 
2 MP, depth sensor; 
2160p@30fps, 1080p@60fps, 1080p@30fps; 
LED flash, panorama, HDR. 

5.2.  Priekinė kamera: Dual  13 MP, f/2.0, 26mm, 
2MP depth sensor; 
6.   Korpusas: 
6.1.  Aliuminis; 
6.2.  Matmenys 156.2x75.2x7.5 mm 

Huawei Y6 
2018 

www.tele2.lt 
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1.    Palaikomi ryšio ir duomenų perdavimo 
standartai: 

1.1. GSM 850/900/1800/1900; 
1.2. WCDMA 850/900/1700/1900/2100; 

1.3. 3G; 4G LTE-A (3CA) Cat12 600/150 Mbps; 
1.4. Bluetooth v4.2, A2DP, LE, aptx; 
1.5. USB v2.0, Type-C 1.0 reversible connector; 
1.6. Wi-Fi 802.11 a/b/g/n/ac, dual-band, WiFi Direct, 

DLNA, hotspot; 
1.7. A-GPS, GLONASS, BDS, Beidou ; 
1.8. DUAL SIM; 
1.9. proximity sensor (atstumo jutiklis), 

accelerometer (akcelerometras) , 
compass (kompasas), 
Gyroscope (giroskopas), 

ZTE MF971VS www.tele2.lt 



 

 

Fingerprint (pirštų atspaudas). 
2. Ekranas:  
2.1. Ekrano dydis 5.1‘‘,LTPS IPS LCD; 
2.2. Ekrano raiška 1080 x 1920; 
2.3. Ekrano spalvos 16M 
2.4. Sensorinio ekrano tipas capacitive; 
2.5. Ekrano ir korpuso santykis 71.2 %; 
2.6. PPI pikselių tankumas ekrane 432; 
2.7. Baterija: talpa ne mažiau 3200 mAh, 
3. Atmintis, Procesorius: 
3.1. RAM atmintis 4 GB; 
3.2. Vidinė telefono atmintis 64 GB; 
3.3. MicroSD kortelės palaikymas iki 256 GB; 

3.4. CPU Octa-core (4x2.4 GHz Cortex-A73 & 
4x1.8 GHz Cortex-A53); 

3.5. GPU Mali-G71 MP8. 
4. Programinė įranga; 
4.1. Android OS 7.0 Nougat; 
4.2. IMAP4,POP3,SMTP protokolai; 
4.3. Naršyklė HTML5; 
5. Kamera: 

5.1    Galinė kamera: Dual 12 MP, f/2.2, 28mm, 
OIS, PDAF & laser 
         AF; 
        20 MP B/W, f/1.8, 2x lossless zoom, PDAF, 
laser AF, Leica   
         optics, dual-LED dual-tone flash, HDR, 
panorama, 
         2160p@30fps, 1080p@60fps. 
5.2.  Priekinė kamera 8 MP, f/1.9 1080p@30fps. 
6.   Korpusas: 
6.1.  Aliuminis ir Stiklas; 
6.2.   Matmenys 145.3x69.3x7mm  

2Techniniai reikalavimai turi būti ne prastesnių ar žemesnių techninių reikalavimų nei nurodyta šio dokumento 3 lentelės 
3 stulpelyje. 
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